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Lesson Objectives

Learn about the different formats available for sales forms

Save sales and purchase forms in portable document format (PDF)
Practice creating a new invoice

Learn the purpose and use of the QuickBooks Item list

See how QuickBooks records the information you enter on sales forms
Memorize an invoice transaction for reuse

Add a new item to the Item list

Add a new price level to the Price Level list

Associate a price level with a customer

Create invoice letters

Generate reminder statements
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Use Sales Forms for Payment in the Future

Any time you make a sale in your business, you record it in QuickBooks on a sales form. A sales form
can be an invoice (when you expect payment to come later), a sales receipt (when you receive
payment at the time you make the sale), or a credit memo (when you issue a credit on your
customer’s account or a customer refund, perhaps because they've returned something they've
bought).

The type of sales form you use (invoice or sales receipt) depends on whether you expect payment in
the future or at the time of the sale. If you expect to receive payment at some future date, you enter
an invoice.

@
2! Step-by-Step: Display a Completed Invoice Form in QuickBooks

1. Open the Customer Center from the Customers drop-down menu (or any of the other access
points).

2. Click on the name of the customer whose invoice you would like to view.

3. From the Transactions tab for that customer, double-click on the invoice to open the invoice form.

Customer Center: Abercrombie, Kristy

A& Mew Customer&Job * JZ| Mew Transactions * (=) Print ¥ Excel * [Ey Word ¥ B Income Tracker
. J
Customers & Jobs Customer Information 02 , o
Active Customers hd >
Company Name Main Phone 415-555-6579
rel FullMame  Mrs. Kristy Abercrombie Main Email kristy@samplename.com
Customer Type  Residential
NAME BALANCE .. | ATT..
< Abercrombie, Kristy 0.00 A Aceountllo. 91431 REPORTS FOR THIS CUSTOMER
: ' Terms et 30
»Family Room 0.00 Bil To Kristy Abercrombie QuickRepart
+Kitchen 0.00 5647 Cypress Hill Rd Open Balance
»Fatio 0.00 Bajshore CAS4320 Show Estimates
+Remodel Bathroom 000 Customer Snapshot
= Alard, Robert 14,510.00 Map | Directions
+Remodel 1451000 | Transactions | Contacts ToDo's Notes SentEmall
+ Babcock's Music Shop 0.00
+Remodel 0.00 ssow Al Transactions | FuTEREY  |All * | pae (Al -
+ Baker, Chris 0.00 TYPE NUM DATE ACCOUN AMOUNT
+Family Room 0.00 =Paymem 12/15i2022 10100 - Checking 7,633.28 =
«Garage Repair 0.00 Estlmale 12M2i2022 90200 - Estimates 7,676.13 '
=+ Utility Shed 0.00 CHECK 1210112022 10100 - Checking 1115
+ Barley, Renee 0.00 Cred\tMemu 4002 12/01i2022 11000 - Accounts Receivable -T11.15
+Repairs 0.00 Elnvmce 1084 11125/2022 11000 - Accounts Receivable 3111.28
«» Bauman, Mark 0.00 :
»Home Remodel 0.00 s Manage Transactions ¥ Run Reports -
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Use Sales Forms for Payment in the Future

Main  Formattng  Send/Ship  Reporis

& P n E 23 Createaﬁupy e

Find New Save Delete @BMemorize
T T Pending

& =

Mark As Print  Email

Print Later @
Email Later Attach

File

[ Add TimeiCosts 7 =)
& Apply Credils

Progress
Payments

= Rock Castle Invoice

| Create a Baich

Receive B Refund/Credit

» Abercrombie, Kristy:Remodel B...

“
>

TaConE

Customer
| H Date BILLTC swipTo |SNIRTO e
n VO I Ce 121012022 @ Kristy Abercrombie Kristy Abercrombie SUMMARY #
€ PaD 12152022 mvoice & e g e Phone 415-555-5579
1091 Email kristy@samplename.com
Preferred delivery method E-mail
TERMS DUE DATE Open balance 0.00
Net 30 ~ 01092024 E Active estimates 1
‘ . . . . . Sales Orders to be invoiced 0
ITEM i DESCRIFTION L QUANTITY | U i RATE i AMOUNT PTAx Unbilled time and expenses: 1,910.00
See attached specifications for details on below work =
Framing Framing labor 16 7150 1,144.00 Mon l CUSTOMER PAYMENT ’
Installation Installation labor 12 4550 546.00 Mon Your custamer can not pay anline
Removal Removal labor 16 4550 728.00 Mon Edit customer preferences
Bubs:Tile &Co... Install tile or counter 825.00 82500 Mon E
v RECENT TRANSACTION =
12/15/22 Payment 763328
“Your customer can't pay this invoice online T 8an Tamas v (7.75%) 0.00 12/12/22 Estimate 7,676.13
Turn on TOTAL 4,522.00
CUSTOMER MESSAGE PEYMENTS AFFLIED 4,522.00 NOTES &
- BALANCE DUE 0.00
MEMO CUSTOMER | Tax - Save & Close Revert

4. Close the invoice (it's already been

close it).

created and saved, and so you can just hit the Esc key to
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Lesson 6 — Enter Sales Information

Use Sales Forms for Payment at the Time of Sale

Use Sales Forms for Payment at the Time of Sale

If you receive full payment at the time you make a sale — either by cash, check or credit card — you fill

out a sales receipt instead of an invoice. Like the invoice, the QuickBooks sales receipt includes
information about the items or services purchased, but it also includes information about how
payment was made. (Think of the sales receipt as the QuickBooks equivalent of a cash register
receipt at a retail store.) The sales receipt completely bypasses the Accounts Receivable account.

v
0

Step-by-Step: Display a Completed Sales Receipt in QuickBooks

1. Open the Customer Center from the Customers drop-down menu (or any of the other access

points).

Receipt form.

Click on the name of the customer whose sales receipt you would like to view.

From the Transactions tab for that customer, double-click on the sales receipt to open the Sales

Enter Sales Receipts

P

=

s payment

Add Credit Card
Processing

ol

Main Formatting Send/Ship Reports Payments
) a E P4 CreateaCopy €@ E = Print Later @ B Add timelcosts Proces
Find New Save Delete @BMemorize Mark As Print  Email Email Later Aftach
- - Pending T - File
CUSTOMER:JO! Family Room GCLASS pEFOSIT TO QUNICORS R S TEMFLATE
H SOLD TO &
DATE
Sales Receipt —
10302022 aﬁﬂhclfbfé:sgﬂ'z?d " Phone 415-555-6579
— = WORE ayshore
ﬁ E 1 | I—_.—Z—I SHENS. v Email kristy@samplename.com
CASH creck | SREDIT | o check v EDLE Open balance 0.00
CHEGK NO. | Active estimates 0
305 | Sales Orders to be invoiced 0
ITEM ! DESCRIPTION i arty UM ! RATE P AMOUNT | TAX Unbilled ime and expenses:  217.94
Removal Removal labor 475 35.00 166.25 Mon _
Repairs Repair work 16.5 35.00 577.50 |Non E
RECENT TRANSACTION =
v 10430122 Sales Receipt 74375
|| 10/25/22 Sales Receipt 1,067.88
TA&X  San Tomas w | (775%) 0.00 0815122 Payment 129278
TOTAL 743.75 06/07/22 Invoice - Paid 0.00
CUSTOMER MESSAGE | 06/07i22 Sales Order 1,293.00
-
HOTES &
MEMO CUSTOMER | Tax - Save & Close Revert
TAX CODE

4. Close the Enter Sales Receipts window.
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Lesson 6 — Enter Sales Information Fillin a Sales Form

Fill in a Sales Form

Filling in an invoice is just like filling in a paper form: enter the customer information first (this will
populate the header portion of the invoice), followed by a description of the charges (this will
populate the detail portion of the invoice).

@
o Step-by-Step: Enter Customer Information on an Invoice

1. Onthe Home page, click Create Invoices (or select CTRL+i or Customers - Create Invoices;
there are several other ways to open the Create Invoices window).

2. If you have custom invoice templates, choose the invoice template you would like to use from the
drop-down list.

3. Inthe Customer:Job field, enter the name of the customer/job for whom you wish to create an
invoice.

4. If the Billable Time/Costs window pops up, choose to add billable time or expenses.

Create Invoices

NOTES

Main Formatting Send/Ship  Reports Hoa
«> B B £ Boemacn @ =g [ Prnt Later B Bawtmecos @R Elcrese ssaen
Find New Save Delste lMemorize Mark As Print  Email Email Later Attach | &g Apply Credits Receive BB Refund/Credit
S o Pending = S File Payments
SISy =t Baker, ChrisFamilyRoom = S| - BN Rock Castie Invoice.
| H DATE EILLTC SHIF TS s &
nVOI Ce 121512022 @ Baker, Chris SUMMARY
p 415 W. Desert Bloom
INVOICE 8
Bayshore, CA 94326 Phone 415-555-2253
1100 Email ChrisB@samplename.com
E-mail
TERMS DUE DATE 0.00
Net 30 v 011402023 @ ctive estimates 0
Sales Orders to be invoiced 0
ITEM i DESCRIPTION P QUANTITY | UM ! RATE { AMOUNT P TAX
USTOMER PAYMENT &
‘our custamer can not pay online
dit customer preferences
v 0
| RECENT TRANSACTION E
| |
“Your customer can't pay this invoice online T |8an Tomas - | (7.79%) 0.00 | 0B/30/22 Payment 517224
Turn on TOTAL 0.00 6123122 Invoice - Paid 517224
CUSTOMER MESSAGE PEYMENTS APPLIED 0.00
. BALANGE DUE 0.00 IOTES &
MEND CUSTOMER | Tax Save & Close Clear
TAEGO0E
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Lesson 6 — Enter Sales Information Fill in the Line Item Area

Fill in the Line Item Area

In the bottom half of the invoice (the detail or body of the invoice), you list each service or product
you're selling on its own line, along with the amount the customer owes for that item. Because
information about individual items is on separate lines, the lines are called line items.

But items are not just products you sell or services you provide to clients. Line items can be anything
you might want to put in the detail area of an invoice, like a discount, subtotal line, markup or sales
tax calculation.

@
2!  Step-by-Step: Complete the Line Iltem Area of an Invoice

1. Inthe Item field, choose the item you would like to add to the invoice. If you chose to add billable
expenses from the last exercise, these items will already appear in this section.

2. Press Tab until you reach the Quantity column.
3. Enter the quantity of the item for which you wish to invoice in the Quantity column.

4. Press Tab to enter the rate or per unit price for this item. If this item has been set up with a
default rate, it will automatically appear on the line, but you can overwrite it.

5. Press Tab to see the amount or extension of the quantity multiplied by the per unit price.

6. Let QuickBooks populate the Tax code for this item automatically, but you can overwrite it by
selecting a different tax code from the drop-down.

ITEM . DESCRIFTION DQUANTL.. @ WM . RATE U AMOUNT @ TAX
=emoval Removal labor 40 3500 1,400.00 Mon 8
NOTES

QuickBooks 2018 Student Guide 10



Lesson 6 — Enter Sales Information Complete the Sales Form

Complete the Sales Form

@
2! Step-by-Step: Complete and Record the Invoice

1. Atthe top of the screen in the Main tab of the ribbon, click on the drop-down under Print and
choose Preview.

Rock Castle Construction InVO‘i ce
1735 County Foad
Bayshore, CA 04326 DATE PIVOICE #
BILL TO =Hm 1O
Bk, T
445 W, Do Bl
EBardee CA B432E
TERME DUEDATE FROJECT
30 vi4a03 Famsly Reem
DESCRIFTION QUANTITY um RATE AMOUNT
rr—p— 41 3500 LML
Subtotal SLAMLY
Sales Tax (7.75%) 000
Total LM
Payments/Credits S
Balance Due Stavan

2. Click Zoom In and use the scroll bars to see the invoice items at greater magnification.
3. Click Close.

4. Invoices and other sales forms can be printed, emailed or saved as PDFs by clicking on the drop-
down under Print or Email in the Main tab of the ribbon at the top of the form.
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Lesson 6 — Enter Sales Information Complete the Sales Form
5. In the Create Invoices window, record the sale and close the window by clicking Save & Close.
QuickBooks records the invoice in your Accounts Receivable register. If this were a sales receipt,
QuickBooks would record the sale in your Undeposited Funds account until you deposit the money
at the bank, or record a deposit into the bank account you specified in the Enter Sales Receipts

window. (The option to select an account in which to deposit the payment is available only when the
Payments preference Use Undeposited Funds as a default deposit to account is turned off.)

The Accounts Receivable register keeps track of how much money your customers owe you.

@
o1  Step-by-Step: See the Accounts Receivable Register

1. Open the Chart of Accounts.

2. Inthe Chart of Accounts, double-click the Accounts Receivable account.

11000 - Accounts Receivable

& Goto.. | &) Print.. | [ Edit Transaction [B) QuickReport

DATE NUMBER CUSTOMER MEM QTy RATE AMT CHRG AMT PAD
TYPE DESCRIFTION CLASS BILLED DATE DUE DATE
201412022 1096 Matiello, ErmestoKitchen 282403 £
INY Paid
2/15/2022 Roche, Diarmuid:Garage repairs 440.00
PMT
21512022 Abercrombie, Kristy:Remodel Bathroom 7,633.28
PMT
2/15/2022 1097 Robson, Darci:Robson Clinic 12,420.98
INY 12M5i2023
2/15/2022 1008 Cook, Brian:Kitchen 1,636.69
INY 114i2024
2/15/2022 1100 Baker, Chris:Family Room 1,400.00
1Y 1M14i2023
2/15/2022 42000 Matiello, Eresto:Kitchen 13,560.39
PMT
B | Number - |item - oy Rate Amt Chrg |
Description Cl.* B [ ] “
1-Line Show open balance ENDING BALANCE 94,407.93
Sotby  Date, Type, MumberRef = | Record | Restore

3. To open atransaction, double-click on the transaction in the register, or click on it once and then
click the Edit Transaction button in the toolbar.

4. Close the register.

QuickBooks 2018 Student Guide 12



Lesson 6 — Enter Sales Information Repeat a Sale

Repeat a Sale

Many of the sales you make in your business are ones you repeat again and again. For example, you
may have a standing monthly order from a customer, or you may perform essentially the same
services for more than one client. QuickBooks lets you memorize sales forms so you don't have to
retype the information. In fact, QuickBooks allows you to memorize a transaction so it is automated
on a schedule if it's something that happens regularly in exactly the same way.

@
o0  Step-by-Step: Memorize the Invoice

1. Make sure you have the invoice you want to memorize displayed on your screen.

2. From the Main tab of the ribbon in the upper right of the task bar, choose Memorize. The
Memorize Transaction window appears on top of the invoice.

Main Formatting Send/Ship Reports oA
& P m E % CrealeaCopy €@ E = Print Later @ B Add Time/Costs B [Ecreate a Bateh
Find New Save Delete €3Memorize Mark As Print  Email Email Later Attach @ Apply Credits Receive B Refund/Credit
T T Pending T T File Payments
IS Baker, ChrisFamily Room = | e - BRI Rock Castle Invoice  +
Customer
| H Dere BILLTO SHIF TD e &
nVOI Ce 121512022 @ Baker, Chris SUMMARY
s - 415 W. Desert Bloom Phone 415-555-2253
Memorize Transaction Email ChrisB@samplename.com
Name |Family Room Example Invoice “ Preferred delivery method E-mail
DUE DATE Open balance 1,400.00
' Addto my Reminders List - Cancel 0 - 011472023 @& Active estimates 0
@ Do Not Remind Mej ™ Sales Orders to be invoiced 0
i [ANE— - .
. )
Removal Removal | Automate Transaction Entry 1,400.00 Mon A
CUSTOMER PAYMENT &
- Your customer can not pay online
Edit customer preferences
v
RECENT TRANSACTION E
Your customer can't pay this invaice online T4 [8an Tomas v (775%) 0.00 12115122 Invoice 1,400.00
Turn on TomL 1.400.00 06/30122 Payment 6,172.24
CUSTOMER MESSABE FAYMENTS AFFLIED 0.00
- BALANCE DUE 1,400.00 HOTES &
e cusrouer [Tax v Save & Close Revert
TAX CODE

3. Inthe Name field, type a description that will help you recognize the memorized invoice or keep
the default description QuickBooks has provided.

4. Click the radio button next to Do Not Remind Me.

5. Click OK.
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6. Close the Create Invoice, Accounts Receivable register and Chart of Accounts windows.

@
9! Step-by-Step: Recall a Memorized Sale

1. From the Lists menu, choose Memorized Transaction List.

ed Transaction List

Repeat a Sale

TR ON NAME i TYPE : N i AMOUNT ! FREQUENCY i NEXT DATE
I -

+ Qverhead General Journal 13100 - Pre-paid Insu... 675.00 Never

« Recurring Depr Entry - Monthly General Journal 54000 - Job Expense... 19.60 Monthly o 12i31/2022
« Sergeant Insurance Check 10100 - Checking 675.00 Monthly 01/15/2023

Memorized Transaction ¥ Enter Transaction

2. Double-click the transaction you just added. Remember, this is just a snapshot copy of an invoice

that you've memorized, not the original invoice.

3. Make any necessary changes on this copy of the memorized invoice (such as the date or other

details) before you save it.
4. Click Save & Close to record the invoice.

5. Pressthe Esc key to close the Memorized Transaction List.

NOTES

QuickBooks 2018 Student Guide
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Create Batch Invoices

Batch invoices are a way to assemble a list of customers to whom you can send similar invoices all at
once. This can be great for recurring service billing.

@
2! Step-by-Step: Create a Batch Invoice

1. From the Customers menu, choose Create Batch Invoices.

2. Click OKto close the Is your customer info set up correctly? message.

Batch Im

Step 1 of 3: Select a billing group or choose customers and click Next.

SEARCH BILLING GROUP

Look for || in  All fields - v

Search Reset [7) Search within results Manage Groups  What is a billing group?

Search Results

MAME & ! BALANCE TO... | TERMS CUSTOMERS IN THIS GROUF
Abercrombie, Kristy ‘

Family Room 0.00 Met 30

Kitchen 0.00 Met 30

Patio 0.00 Net 30 Add>

Remodel Bathroom 0.00 Met 30 < Remove
Allard, Robert 14,510.00 Met 15

Remodel 14,510.00 Net 15
Babcock’s Music Shop 0.00 Met 15

Remodel 0.00 Met 15
Baker, Chris 1,400.00 Met 30

Family Room 1,400.00 Met 30

v
Select All Clear All Save Group

Back m Help Cancel

3. Inthe Look for field, you can search for an item description.

4. Click Search.
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Create Batch Invoices

5. Inthe Billing Group field, enter a name for your batch. If you enter a name that does not exist,

you will receive a prompt to set up this group.

6. Highlight each client from the search results you wish to add to the Billing Group or you can click
Select All. Use the Add button to add clients to your list.

SEARCH

Step 1 of 3: Select a billing group or choose customers and click Next.

Lookfor shed
Search Reset

Search Results

NAME &
Matiello, Ernesto

-

Keenan, Bridget:Storage Shed

nya:Uility
can, Dave:Utility Shed

Jimenez, Cristina:Utility She
Johnson, Gordon:Ut
Memeo, Jeanette: Utility
Overfield, David:Utility Shed

Select All Clear All

[ Search within results

i BALANCE TO... ! TERMS

Add >

< Remaove

BILLING GROUP

Sheds

Manage Groups Whatis a billing group?

Billing group ©  Sheds

CUSTOMERS IN THIS GROUF

Matiello, Ernesto

Keenan, Bridget:Storage Shed
Balak, Mike:Utility Shed
Bristol, Sonya:Utility Shed
Duncan, Dave:Utility Shed
Dunn, Eric CW.:Utility Shed
Fomin, Slava:Utility Shed
Jimenez, Cristina:Utility Shed
Johnson, Gordon:Utility Shed
Memeo, Jeanette: Utility Shed
Owerfield, David:Utility Shed

Save Group

Help

Cancel

7. Click Save Group.

8. Click Next.

9. Choose the date of the invoices that are being issued in one batch as well as the invoice

template you wish to use for the entire batch.

10. Enter the information you would like on your invoice.

11. Click Next.

12. Review the list of customers checked in the next window and click Create Invoices.

13. The Batch Invoice Summary appears. Click Email to send the invoices to your customers or Print

to print the invoices.

14. Click Close to close the Batch Invoice Summary.

QuickBooks 2018 Student Guide
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Lesson 6 — Enter Sales Information Enter a New ltem

Enter a New Item

ltems are what we use on sales forms like estimates, sales orders, invoices and sales receipts. Items
show the products/services that are sold and each item is mapped to one or more accounts in
QuickBooks. Items can be mapped to one, two or three accounts, depending on the item setup.

® One-sided items - These items are used on either a sale or a purchase form, but not both. For
example, if you sell consulting services, you may have an item named Consulting for use on your
invoices. This item will be mapped to an income account to view on your Profit & Loss report. If
this item (meant for sales transactions, in this example) were used on a purchase transaction, it
would post a negative transaction to your income account.

® Two-sided items - These items are used on both a sale and a purchase form. The setup of these
items allows you to post to an income account when used on a sales form and post to an
expense account when used on a purchase form.

® Three-sided items - These items are used for inventory. The setup of these items allows you to
purchase the item and receive it into your Inventory asset account (part 1). When you sell the
inventory, the item posts to your Income account (part 2) and makes a Cost of Goods Sold entry
(part 3).

In this section we will look at a one-sided item entry.

QuickBooks 2018 Student Guide 17



Lesson 6 — Enter Sales Information Enter a New Item

@
9! Step-by-Step: Add a One-sided Item

1. From the Lists menu, choose Item List.

Look for in Allfields U Reset Search within results
NAME DESCRIPTION TYPE ACCOUNT TOTAL QUANTITY ... | ON SALE... | PRICE ATTACH
+Roofing Roofing Senvice 40100 - Constructio... 0.00
+Tile &Cou... Install tile or counter Senvice 40100 - Constructio... 0.00
+ Cabinets Cabinets Inventory Part 40100 - Constructio 0 0 0.00
«Cabinet P... Cabinet Pulls Inventory Part 40100 - Constructio... 423 0 0.00
+Light Pine |Light pine kitchen cabinet wall unit Inventory Part 40100 - Constructio... 6 2 1,799.00
+ Door Frame  standard interior door frame Inventory Part 40100 - Constructio... 21 0 0.00
» Hardware Inventory Part 40100 - Constructio 0 0 0.00
«Brass hin... standard interior brass hinge Inventory Part 40100 - Constructio... 246 0 0.00
+Doorknob... Standard Doorknobs Inventory Part 40100 - Constructio... 124 0 30.00
+Lk Doork... Locking interior doorknobs Inventory Part 40100 - Constructio... 122 0 38.00
» Wood Door Doars Inventory Part 40100 - Constructio 1 0 0.00
< Exterior Exterior wood door Inventory Part 40100 - Constructio... 16 0 120.00
«Interior Interior wood door Inventory Part 40100 - Constructio... 47 0 72.00
« Interior Door... complete Interior door Inventory Assem... 40100 - Constructio... 20 0 0.00
> Lumber Lumber Non-inventory P.. | 40100 - Constructio 0.00
<Trim Trim lumber Mon-inventory P.. 40100 - Constructio... 0.00
+Decking Decking lumber MNon-inventory P.. 40100 - Constructio... 0.00
+Rough Rough lumber Non-inventory P.. 40100 - Constructio... 0.00
ltem ¥ Activiies v Reporis v Excel ¥ | Attach Include inactive

2. Click the Item menu button at the bottom left of the window then choose New.
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3. Inthe New Item window, choose an item type from the Type drop-down list.

Enter a New Item

= IMPORTANT: When you select an item type, a description of how that item should be used will appear to

the right of the drop-down box.

Mew ltem
TYPE
Senice Use for services you charge for or purchase, like
specialized labor, consulting hours, or professional
fees.
ltem Mame/Mumber Subitem of
UNIT OF MEASURE
UM Set - Edit...

This service is used in assemblies or is performed by a subcontractor or partner

Description Rate 0.00
Tax Code Tax b
Account

How can | set rates by customers or employees?

Cancel

Next
Notes
Custom Fields

Spelling

Item is inactive

4. Assign an item name or number in the ltem Name/Number field.

5. Inthe Description field, enter the default information you would like to appear when this item is

used on a form. (This information can be overwritten on any individual transaction.)

6. You can assign a standard per unit selling price in the Rate field.

7. Inthe Tax Code field, assign a standard taxable or non-taxable code.

= IMPORTANT: ltems marked as Non-taxable in the setup will not accrue sales tax on sales forms. See the

Sales Tax training section for additional information.

8. Inthe Account field, choose the appropriate Income account to post to when this item is used on

sales forms.
9. Click OK to add the new item to the Item List.

10. Close the Item List.

QuickBooks 2018 Student Guide
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Lesson 6 — Enter Sales Information Create New Price Levels

Create New Price Levels

For each price level you create, you assign a name and percentage increase or decrease to the
item’s base or standard sales price. You can create up to 100 price levels in QuickBooks Pro and
Premier to use on invoices, sales receipts, estimates and credit memos. To enable price levelsin a
company, click Edit >Preferences > Sales & Customers > Company Preferences > Enable Price
Levels.

@
2! Step-by-Step: Create a New Price Level

1. From the Lists menu, choose Price Level List.

Price Level List —

MAM TYFE DETAILS

Commercial Fixed %
Industrial Fixed % -15.0%
Residential Fixed % -5.0%
Door Replacement Special Perltem varies peritem
Kitchen Upgrade Package Per ltem varies per item
Fretell Real Estate Rates Per ltem varies per item

Price Level = Reports -

2. From the Price Level menu button, choose New.
3. Inthe Name field, enter a name for the price level.

4. From the Type drop-down list, select Fixed % or Per Item. This setting determines if you have a
fixed markup/discount or if you would like to set up custom prices per item. (Per Item Price
Levels are not available in QuickBooks Desktop Pro.)

5. Setyour rounding parameters.
6. Click OK.

7. Close the Price Level List.
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Associate Price Levels with Customers

When you assign price levels to customers, QuickBooks calculates rates and amounts on sales forms
based on the price level associated with that customer.

@
9! Step-by-Step: Associate a Price Level with a Customer

1. Open the Customer Center.

2. Inthe Customers & Jobs List, select the customer whose price level you wish to set.
3. Double-click on the customer name to open the customer detail page.

4. Click the Payment Settings tab.

5. From the Price Level drop-down list, choose the price level you want to associate with the
customer.

Edit Customer

cusToMER Nave | Lew Plumbing - C

CURRENT BALANCE 220.00 How dao | adjustthe current balance?
Address Info
AGCOUNT NO. CREDIT LIMIT
Payment Settings -
£ay 9 FAYMENT TERMS | MNet 30 - FRICE LEVEL [bommermal ']
Sales Tax Settin ) -
= as PREFERRED [ il -
DELIVERY METHOD
Additional Info FREFERRED [pr—r= o -
PAYMENT METHOD
CREDIT CARD INFORMATION ONLINE PAYMENTS

CREDIT CARD NO. | 9922 3327 Let this customer pay you by:

R i b S
EXF.DATE 08 | / 2005 Credit Card s @) |2 ==

Bank Transfer (ACH) B0

MAME OM CARD | Lew Plumbing

apbrEss 221 01d Bayshore Rd

ZIF / FOSTAL CODE | 94326

Can | save the Card Security Code?

Customeris inactive “ Cancel Help

6. Click OK to close the Edit Customer window and save your changes.
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Now when you create a sales form for this customer, the price will automatically be adjusted
according to the price level. However, you will still have the opportunity to select the base or
standard price, or any of the other prices associated with other price levels, for each item (by clicking
on the drop-down next to the rate that appears). You will also be able to overwrite the price
altogether and enter a custom price for this sales form. See the next section, Assign Price Levels to
Individual Line Items, for situations in which you might want to use this feature.

NOTES
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Assign Price Levels to Individual Line Items

In addition to associating price levels with customers, you can also use price levels on an individual
basis on sales forms. Some examples of when you might want to do this are:

® You've associated a price level with a customer but want to charge the base sales price for an
item on a sale to that customer

® You wantto use a price level for one or more items but you don’t want to assign a price level to
the customer for whom you're recording the sale

@
2! Step-by-Step: Apply a Price to a Single Line ltem

1. In asales form with line items, click in the Rate column and select the price level you want to use
from the drop-down list that displays (or you can enter your own price for that item, even if it is
not in the drop-down list).

2. When you move out of that field on the form, QuickBooks recalculates the amount and balance
due.

NOTES
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Use the Income Tracker

The Income Tracker Center helps you manage collecting payments from your customers. It lists all
overdue and nearly-due invoices in a single place, as well as unbilled estimates. You can send email
reminders to one customer or many customers, and it tracks customer notes about your collection
efforts.

@
2! Step-by-Step: Review Overdue and Nearly-Due Payments

for All Customers

1. From the Customers menu, select Income Tracker (or open the Customer Center and click on
Income Tracker).

2. Click on any of the money bar’s colored tabs on the top to filter the information, if desired.

Income Tracker

UMBILLED UNPAID PAID
48,569.31 1,413.68 31,583.33
€ ESTIMATES 3 SALES ORDERS 17 TIME & EXPENSES 0 OVERDUE
cusTomER-Jos (Al [=] wvee A - swmus (Al ~| oae AN -
[ : cusTomer TYPE NUMBER : DATE ¥ DUE DATE AMOUNT OPEN BALANCE | LAST SENTDATE : STATUS ACTION
| S K S IS T I N == -
[] Cook, Brian:Kitchen Invoice 1098 121522 114i24 1,636.69 1.636.69 Open
[ Morgenthaler, Jenny:Ro... Sales Order 7003 1211522 11424 271.53 27153 Open
[ Natiello, Emesto Invoice 101 12115122 114023 1,435.00 1,435.00 Open
[ Robson, Darci:Robson. Invoice 1097 1215122 121523 12,420.98 12,420.98 Open
[] Lew Plumbing - C:Stora... Invoice 1093 1212122 1124 220.00 220.00 Open
[] Cook, Brian:Kitchen Invoice FC#6 12Mmi22 11024 5.95 5.95 Open
[] Campbell, Heather.Rem... Invoice 1092 1210022 12125123 13,900.00 13,900.00 Open
[] Pretell Real Estate: 155 Invoice 1090 1210122 1/09/24 1,715.00 1,715.00 Open
[] Violette, Mike:Workshop  Invoice 1089 12/05/22 2103124 573223 473223 Open
[] Ecker Designs:Office R Invoice 1086 1173022 12/30/23 1,468 30 1,468 30 Open
[] Teschner, Anton:Sun Ro... Invoice 1085 11728122 1213123 8,305 95 56595 Open
[ Burch, Jason:Room Ad. Invoice 1083 1172522 12/25/23 1,005.00 1,005.00 Open
[ Cook, Brian:2nd story a... Invoice 1081 1172522 12/25/23 5,418.00 5,418.00 Open .
t Batch Actions. - Manage Transactions - Showing 1 - 49 of 49 d &

3. Click on the down-facing arrow next to Select in the Action column for a list of actions you can
take with each line.

4. Inthe Unbilled section (the left half) of the money bar, click on the colored tab for Estimates.
These are open estimates that can be turned into invoices by using the Action field.
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5. Place checkmarks in the boxes in the far left column next to each estimate (or one checkmark in
the top box to indicate you are choosing all of them). Click on Batch Actions at the bottom
which, in this case, enables you to batch email them or mark them inactive.

6. The Manage Transactions button at the bottom enables you to launch a new customer-related
transaction such as a new invoice or estimate, or to edit the currently highlighted row.

7. Close the Income Tracker.

NOTES
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Create Single Invoice Letters

@
o Step-by-Step: Create an Invoice Letter

1. From the Reports menu, choose Customers & Receivables, and then choose Open Invoices
from the submenu.

2. Inthe on-screen Open Invoices report, double-click the open invoice for which you would like to
send a letter.

3. Under the Send/Ship tab of the ribbon at the top, click the Prepare Letter icon to display the
drop-down list.

4. Select Prepare Letter. If QuickBooks prompts you to find letters, click Copy.

5. Choose the type of letter you wish to create.

Letters and Envelopes

IDETCTOIMTIDIE
lypress HillRd | Choose a Letter Template
nre CA 94326

(® Letter templates available for invoice letters.

Irs. Kristy Aberg {Cover Letter

Invoice Letter with Details

EWindow Envelope Cover Letter

%Window Envelope Invoice Letter with Details

() Create or Edit a letter template.

6. Click Next.
7. Enter the appropriate name and title for the letter signature.

8. Click Next.
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Create Single Invoice Letters

9. Inthe next screen, indicate whether you wish to print envelopes as well. If you wish only to print a

letter, select Cancel.

Rock Castle Construction
1735 County Road
Bayshore, CA 94326

December 15, 2022
Baker, Chris

415 W. Desert Bloom
Bayshore, CA 94326
Dear Chris,

This table summarizes your current invoice activity. Please review this information and let us
know if you have any questions.

Invoice Job Family Room
Invoice Number 1100

Invoice Date 12/15/2022
Invoice Due Date 01/14/2023
Invoice Amount $1,400.00
Invoice Balance $1,400.00

ltemized charges are shown below:

ltem Description Qty  Rate Amount Tax
Remaoval Removal labor 40 3500 140000 MNon

Thank you for choosing Rock Castle Construction. We hope to work with you again in the future

Sincerely

Esther Friedberg Karp
President forLife
Rock Castle Construction

10. You can choose to print the letter (and envelope) from Microsoft Word® if you wish.

11. From the Window menu, choose Close All.

NOTES
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Generate Reminder Statements

Reminder statements summarize a customer's account by listing recent invoices, credit memos and
payments received. You can use reminder statements when you bill through invoices but want to
remind your customers about delinquent payments and/or total outstanding balances.

Reminder statements are different from other forms in QuickBooks such as invoices, sales receipts or
checks in that they are not transactions. Furthermore, because QuickBooks already has all the
information you need to create reminder statements, you don't have to fill them out. Instead, you
review the information that will appear on each statement, decide whether to add finance charges,
and generate them.

@
o0 Step-by-Step: Generate Reminder Statements

1. Click Home to display the Home page, and then click Statements (or from Customers, select
Create Statements).

Create Statements

SELECT STATEMENT OPTIONS SELECT ADDITIONAL OPTIONS

Statement Date 121152022 @ Template

@ Statement Period From  11/16/2022 B To 421512022 [ Intuit Standard Statement - Customize

) All open fransactions as of Statement Date Create One Statement  Per Customer =
Show invoice item details on statements
Print statements by billing address zip code

SELECT CUSTOMERS #| Print due date on transactions

® All Customers Do not create statements:
O Multiple Customers with a zero balance
™ One Customer with a balance less than
' Customers of Type with no account activity
7 Preferred Send Method for inactive customers
View Selected Customers... Assess Finance Charges...
Preview Print E-mail Close Help

2. For Statement Date, enter the date you want to appear on the statement.

QuickBooks 2018 Student Guide 28



Lesson 6 — Enter Sales Information Generate Reminder Statements

3. Set your statement period in the Statement Period From/To fields, or select All open
transactions as of statement date.

4. In the Select Customers section, choose how you would like to create the statements. Select
additional options as they apply. Click Assess Finance Charges if you would like to add finance
charges to the statements. (If you want to assess finance charges without sending out statements,
you can click on Customers - Assess Finance Charges or access the Finance Charges icon
from the Home page.)

Create Statements

SELECT STATEMENT OPTION § SELECT ADDITIONAL OPTIONS
Statement Date 1211512022 B Template
© Statement Period From To Intuit Standard Statement = Customize
® All open transactions as of Statement Date Create One Statement  Per Customer b
Include anly transactions over days past due date bd éSth invoice item details on statements§
Print statements by billing address zip code
SELECT CUSTOMERS | Print due date on transactions
@ All Customers Do not create statements:
1 Multiple Customers with a zero balance
T One Customer « with a balance less than 500
T Customers of Type with no account activity
O Preferred Send Method for inactive customers
View Selected Customers... Assess Finance Charges...
Preview Print E-mail Close Help
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5. Enter an assessment date in the next window (the Assess Finance Charges window) if applicable.
Click Assess Charges.

Finance Charges

Click the assess column for each customer for whom you wish to create a finance charge invoice.

Assessment Date

1211520228 Finance Charge - Customize
ASS.. | LASTFC ! CUSTOMER ! OVERDUE BAL. ! FINAMCE CHARGE
Allard, Robert 0.00 _
v Remodel 14,510.00 966.01
v
Mark All Unmark All ] Mark Invoices “To be printed”

Customers with *s have payments or credit memos which have not been
applied to any invoice. The overdue balance does not include these credits.

Settings... Collection History Assess Charges Cancel

6. Back in the Create Statements window, click Preview.
7. Click Close.

8. Close the Create Statements window.

NOTES
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Enter Sales Information — Review Questions

1. When receiving payment at the time of sale, you create a in
QuickBooks.

2. When customers are returning items, you record the return on a

3. In QuickBooks you can record payments by customers made using which of the following?

a.

b.

C.

d.

Cash
Check
Credit card

All of the above

4. True or false: QuickBooks lets you save sales forms as PDF files.

a.
b.

5. If you regularly invoice a customer for similar items or services, you can

True

False

the invoice to save time.
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6. From which list (or lists) does QuickBooks get the information for A, B and C in the graphic
below?

Main Formatting Send/Ship Reports oA
Email FedEx UPS USPS Mail  Prepare
h T T T Invoice  Letter »
—_— — — IR Sl = N s PN
cus a S0t Remodsl - Rock Castle | - > Abercrombie temodel B...
CUSTOMER:JOB cLass [GEWGEE =l Rock Castle Invoice | S S S5 77 v
J‘ Customer | 4’?{\ -‘-&\”%‘:
| nvo'ce DATE BILLTO swipTo (ShipTo 1 e ; & |
1210/2022 B | Kristy Abercrombie Kristy Abercrombie v.\\ SUMMARY |
. 5647 Cypress Hill Rd 5647 Cypress Hill Rd | | |
PAID 12/15/2022 INVOICE & | | |
<9 Bayshore CA24325 Bayshore, CA 94225 jj Prone 415-555-6579 |
1091 | Email kristy@samplename.com |
% Preferred delivery method E-mail |
TERME DIUE DATE | Open balance 0.0
Met 30 01/09/2024 gi Active estimates
. . ‘ ‘ ‘ ‘ "S Sales Orders to be invoiced 0
ITEM i DESCRIPTION P QUANTITY | U i RATE : i TAX a\ Unbilled ime and expenses:  1,910.00 |
See attached specifications for details on below work. |‘ ]
Framing Framing labor 16 7150 1,144.00 Non ' s-f CUSTOMER PAYMENT ’
Installation Installation labor E 12 4550 546.00 |Mon % Your customer can not pay online
Removal Remaoval labor 16 4550 728.00 MNon \" Edit customer preferences
A\
;‘-
|| RECENT TRANSACTION
— |
“Your customer can't pay this inveice onling T4 'san Tomas *  (7.75%) 0.00 ; Loading
Turn en TOTAL 452200 J‘
CUSTOMER MESSAGE FEVMENTS AFFLIED 452200 |
| |
. BALANGE DUE 0.00 || notes ¢
% Loading.
MEMO CUSTOMER | Tax - Save & Close Save & New Revert gl |
Ry welni - -

7. Listthe item types used in the line item area of the invoice above.

8. On which of the following can you not use price levels?
a. Invoices
b. Sales receipts
c. Creditmemos

d. Purchase orders
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9. QuickBooks Pro allows you to assign price levels to which of the following?
a. Specific customers
b. Individual line items on sales forms
c. Bothaandb
d. None of the above

10. If a wood door’s base price is $120.00 and you set the rounding option to 1.00 minus .11 for a
certain price level, what price might appear on an invoice for the wood door if that price level is

used?

a. $120.11
b. $120.89
c. $119.89
d. $119.11

11. Which of the two methods described in this lesson for providing customers with information
about overdue invoices allows you to assess finance charges?

a.

b.
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Review Activities

1. Create an invoice for Rock Castle Construction that uses the new Repairs:Plumbing line item.
Create the invoice for a new customer by adding information to the Customer list on the fly.

2. Filling out a sales receipt is similar to filling out an invoice form. Create a sales receipt for the
customer Rock Castle Construction and select the Undeposited Funds option. (You need to
select this option only if the preference to use that account as the default deposit to account is
not set.) After you create the sales receipt, open the Undeposited Funds account register to see
the transaction QuickBooks created automatically.

3. Create a new price level for Rock Castle Construction for their January sales event. You want all
the prices to be 10% off and rounded to the nearest $.95. Then create an invoice and add some
items. Apply the January sales event price level and see the effect on the price. How would you
change the price level so all prices are rounded to the nearest $.49?
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Answers to Review Questions

1. When receiving payment at the time of sale, you create a sales receipt in QuickBooks.
2. When customers are returning items, you record the return on a credit memo.
3. In QuickBooks you can record payments received from customers using which of the following?
a. Cash
b. Check
c. Credit card
d. Y'All of the above
4. True or false: QuickBooks lets you save sales forms as PDF files.
a. vTrue
b. False

5. Ifyou regularly invoice a customer for similar items or services, you can memorize the invoice to
save time.
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6. From which list (or lists) does QuickBooks get the information for A, B and C in the graphic
below?

a. Customers & Jobs List

b. Customers & Jobs List (if associated terms with the customer); Terms List

c. ltem List

Main  Formatting Send/Ship Reports HoaA
= @ @ ® & D
Email FedEx UPS USPS Mail  Prepare
2 2 = = Invoice  Letter -
CUSTOMER:JO model Bathroo CLASS Si= 0= Rock Castle Invoice -
|nV0|ce DATE BILLTO suipTo (SMIPTO 1 e o
12102022 B Kristy Abercrombie Kristy Abercrombie SUMMARY
- - 5647 Cypress Hill Rd 5647 Cypress Hill Rd
PAID 1215/2022 INVOICE
o : Bayshore CA94326 Bayshore, CA94326 Phone 415-555-6579
1091 Email kristy@samplename.com
Preferred delivery method E-mail
TERMS DUE DaTE Open balance 0.00
Met 30 01/09/2024 & Active estimates 1
‘ . . ‘ . . Sales Orders to be invoiced 0
ITEM : DESCRIFTION P QUANTITY | Ui i RATE i AMOUNT Tax Unbilled time and expenses: 1,910.00
See attached specifications for details on below work. |“
Framing Framing labor 16 71.50 1,144.00 Non ' CUSTOMER PAYMENT &
Installation Installation labor E 12 4550 546.00 MNon Your customer can not pay online
Removal Removal labor 16 45.50 728.00 Mon Edit customer preferences
v
RECENT TRANSACTION ﬁ‘
“Your customer can't pay this invoice onling T+ gan Tomas - | (775%) 0.00 Loading...
Turn on ToTAL 4,522.00
CUSTCMER MESSAGE FAYMENTS APFLIED 4.522.00
. BALANGE DUE 0.00 NOTES s
Loading.
MEMO CUSTOMER | Tax L) Save & Close Save 8 New Revert
Ticona

7. Listthe item types used in the line item area of the invoice above.
Service
8. On which of the following can you not use price levels?
a. Invoices
b. Sales receipts
c. Creditmemos

d. v'Purchase orders
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9. QuickBooks Pro allows you to assign price levels to which of the following?

a.

b.

C.

d.

Specific customers
Individual line items on sales forms

v'Both a and b

None of the above

10. If a wood door’s base price is $120.00 and you set the rounding option to 1.00 minus .11 for a
certain price level, what price might appear on an invoice for the wood door if that price level is

used?

a. $120.11
b. $120.89
c. V$119.89
d. $119.11

11. Which of the two methods for providing customers with information about overdue invoices
allows you to assess finance charges?

a.

b.

Invoice letters

v'Reminder statements
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